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Chapter 4
Working with Math

This chapter describes the elements of Mathcad math expressions
mechanics of creating and editing math expressions, and ways of 
controlling the appearance of math expressions.

The following sections make up this chapter:

Inserting math
How to enter math into a Mathcad worksheet. Introduction to the elemen
Mathcad math expressions: numbers, vectors and matrices, strings, nam
and operators.

Building expressions
How to create mathematical expressions in a straightforward way by just 
typing a stream of characters. How to create expressions by exploiting their 
structure.

Editing expressions
Inserting and deleting operators, changing the names of variables, and us
Cut, Delete, Paste, and Copy, as well as equation drag and drop, to strea
your editing.

Math styles
How to assign particular fonts, font sizes, font effects, and colors to the 
elements of your math regions.
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Inserting math

You can place math equations and expressions anywhere you want in a Mathca
worksheet. All you have to do is click in the worksheet and start typing.

■ Click anywhere in the worksheet. You see 
a small crosshair. Anything you type ap-
pears at the crosshair.

■ Type numbers, letters, and math operators, 
or insert them by clicking buttons on 
Mathcad’s math toolbars, to create a math 
region.

You’ll notice that unlike a word processor, Mathcad by default understands anyth
you type at the crosshair cursor as math. If you want to create a text region instead, 
follow the procedures described in Chapter 5, “Working with Text.”

You can also type math expressions in any math placeholder, which appears when you
insert certain operators. See Chapter 9, “Operators,” for more on Mathcad’s math
ical operators and the placeholders that appear when you insert them.

The rest of this chapter introduces the elements of math expressions in Mathcad
describes the techniques you use to build and edit them. See the chapters in the
Computational Features section of this User’s Guide for details on numerical and 
symbolic calculation in Mathcad.

Numbers and complex numbers

This section describes the various types of numbers that Mathcad uses and how to
them into math expressions. A single number in Mathcad is called a scalar. For 
information on entering groups of numbers in arrays, see “Vectors and matrices” on 
page 48.

Types of numbers

In math regions, Mathcad interprets anything beginning with one of the digits 0–
a number. A digit can be followed by:

■ other digits

■ a decimal point

■ digits after the decimal point

■ one of the letters b, h, or o, for binary, hexadecimal, and octal numbers, or i  or j  
for imaginary numbers. These are discussed in more detail below. See “Suffi
for numbers” on page 348 in the Appendices for additional suffixes.
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Note Mathcad uses the period (. ) to signify the decimal point. The comma (, ) is used to separate 
values in a range variable definition, as described in “Range variables” on page 125. So w
you enter numbers greater than 999, do not use either a comma or a period to separate dig
groups of three. Simply type the digits one after another. For example, to enter ten thousan
“10000 ”. 

Imaginary and complex numbers
To enter an imaginary number, follow it with i or j, as in 1i  or 2.5j . 

Note You cannot use i or j alone to represent the imaginary unit. You must always type 1i  or 1j . If 
you don’t, Mathcad thinks you are referring to a variable named either i or j. When the cursor is 
outside an equation that shows 1i or 1j, however, Mathcad hides the superfluous 1.   

Although you can enter imaginary numbers followed by either i or j, Mathcad 
normally displays them followed by i. To have Mathcad display imaginary number
with j, choose Result from the Format menu, check the “Set as default” box, an
set “Imaginary value” to “ j(J).”. See “Formatting results” on page 134 for a full 
description of the result formatting options.

Mathcad accepts complex numbers of the form  (or ), where a and b 
are ordinary numbers.

Binary numbers
To enter a number in binary, follow it with the lowercase letter b. For example, 
11110000b  represents 240 in decimal. Binary numbers must be less than 

Octal numbers
To enter a number in octal, follow it with the lowercase letter o. For example, 
25636o  represents 11166 in decimal. Octal numbers must be less than 

Hexadecimal numbers
To enter a number in hexadecimal, follow it with the lowercase letter h. For 
example, 2b9eh  represents 11166 in decimal. To represent digits above 9, use
upper or lowercase letters A through F. To enter a hexadecimal number that begin
with a letter, you must begin it with a leading zero. If you don’t, Mathcad will thi
it’s a variable name. For example, use 0a3h  rather than a3h  to represent the 
decimal number 163 in hexadecimal. Hexadecimal numbers must be less than

Exponential notation 
To enter very large or very small numbers in exponential notation, just multip
number by a power of 10. For example, to represent the number , type
3*10^8 .

a bi+ a bj+

231

231

231

3 108⋅
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Vectors and matrices    

A column of numbers is a vector, and a rectangular array of numbers is called a matrix. 
The general term for a vector or matrix is an array. 

There are a number of ways to create an array in Mathcad. One of the simplest 
filling in an array of empty placeholders as discussed in this section. This techniq
useful for arrays that are not too large. See Chapter 11, “Vectors, Matrices, and 
Arrays,” for additional techniques for creating arrays of arbitrary size.

Tip You may wish to distinguish between the names of matrices, vectors, and scalars by font
example, in many math and engineering books, names of vectors are set in bold while th
scalars are set in italic. See “Math styles” on page 67 for a description of how to do this.

Creating a vector or matrix

To create a vector or matrix in Mathcad, follow these steps:

■ Choose Matrix  from the Insert menu or 

click  on the Matrix toolbar. The dia-
log box shown on the right appears.

■ Enter a number of rows and a number of 
columns in the appropriate boxes. In this 
example, there are two rows and three 
columns. Then click “Create.” Mathcad 
inserts a matrix of placeholders. 

■ Fill in the placeholders to complete the 
matrix. Press [Tab ] to move from place-
holder to placeholder. 

You can use this matrix in equations, just as you would a number.

Tip The Insert Matrix  dialog box also allows you to insert or delete a specified number of rows
columns from an array you have already created. See“Changing the size of a vector or m
on page 219.
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Note Throughout this User’s Guide, the term “vector” refers to a column vector. A column vector is 
simply a matrix with one column. You can also create a row vector by creating a matrix with one 
row and many columns. 

Strings

Although in most cases the math expressions or variables you work with in Math
are numbers or arrays, you can also work with strings (also called string literals or 
string variables). Strings can include any character you can type at the keyboard,
including letters, numbers, punctuation, and spacing, as well as a variety of spec
symbols as listed in “ASCII codes” on page 353 in the Appendices. Strings differ f
variable names or numbers because Mathcad always displays them between do
quotes. You can assign a string to a variable name, use a string as an element of a
or matrix, or use a string as the argument to a function.

To create a string:

■ Click on an empty math placeholder in a 
math expression, usually on the right-hand 
side of a variable definition.

■ Type the double-quote (" ) key. Mathcad 
displays a pair of quotes and an insertion 
line between them.

■ Type any combination of letters, numbers, 
punctuation, or spaces. Click outside the 
expression or press the right arrow key 
(→) when you are finished.

To enter a special character corresponding to one of the ASCII codes, do the following:

■ Click to position the insertion point in the string.

■ Hold down the [Alt ] key, and type the number “0” followed immediately by the
number of the ASCII code using the numeric keypad at the right of the keyboard in 
number-entry mode. 

■ Release the [Alt ] key to see the symbol in the string. 

For example, to enter the degree symbol (° ) in a string, press [Alt ] and type “0176” 
using the numeric keypad.

Note The double-quote key (" ) has a variety of meanings in Mathcad, depending on the exact loca
of the cursor in your worksheet. When you want to enter a string, you must always have a blank 
placeholder selected.
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Valid strings include expressions such as “The Rain in Spain Falls Mainly on the Pl
“Invalid input: try a number less than -5,” and “Meets stress requirements.” A strin
Mathcad, while not limited in size, always appears as a single line of text in your
worksheet. Note that a string such as “123,” created in the way described above
understood by Mathcad to be a string of characters rather than the number 123.

Tip Strings are especially useful for generating custom error messages in programs, as descr
Chapter 15, “Programming.” Other string handling functions are listed in “String functions”
page 213. Use strings also to specify system paths for arguments to some Mathcad built-
functions; see “File access functions” on page 214. 

Names     

A name in Mathcad is simply a sequence of characters you type or insert in a ma
region. A name usually refers to a variable or function that you use in your comp
tions. Mathcad distinguishes between two kinds of names:

■ Built-in names, which are the names of variables and functions that are alway
available in Mathcad, and which you can use freely in building up math express

■ User-defined names, which are the names of variables and functions you cre
your Mathcad worksheets.

Built-in names

Because Mathcad is an environment for numerical and symbolic computation, a 
number of names are built into the product for use in math expressions. These bu
names include built-in variables and built-in functions. 

■ Mathcad includes several variables that, unlike ordinary variables, are alread
defined when you start Mathcad. These predefined or built-in variables either have 
a conventional value, like π (3.14159...) or e (2.71828...), or are used as system 
variables to control how Mathcad calculates. See “Built-in variables” on page 
for more information.

■ In addition to these predefined variables, Mathcad treats the names of all bui
units as predefined variables. For example, Mathcad recognizes the name “A
the ampere, “m” as the meter, “s” as the second, and so on. Choose Unit  from the 

Insert menu or click  on the Standard toolbar to insert one of Mathcad’s 
predefined units. See “Units and dimensions” on page 131 for more on built-in u
in Mathcad. 

■ Mathcad includes a large number of built-in functions that handle a range of 
computational chores ranging form basic calculation to sophisticated curve fitt
matrix manipulation, and statistics. To access one of these built-in functions, 
can simply type its name in a math region. For example, Mathcad recognizes
name “mean” as the name of the built-in mean function, which calculates the 
arithmetic mean of the elements of an array, and the name “eigenvals” as the 
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of the built-in eigenvals function, which returns a vector of eigenvalues for a matr

You can also choose Function from the Insert menu or click  on the Standard
toolbar to insert one of Mathcad’s built-in functions. See Chapter 10, “Built-in
Functions,” for a broad overview of Mathcad’s built-in functions.

User-defined variable and function names

Mathcad lets you use a wide variety of expressions as variable or function name

Names in Mathcad can contain any of the following characters:

■ Uppercase and lowercase letters.

■ The digits 0 through 9, available on the keyboard or the Arithmetic toolbar. 

■ The underscore (_ ). 

■ The prime symbol (' ). Note that this is not the same as an apostrophe. You’ll fi
the prime symbol on the same key as the tilde (~).

■ The percent symbol (%).

■ Greek letters. To insert a Greek letter, click a button on the Greek toolbar or 
the equivalent roman letter and press [Ctrl ]G. The section “Greek letters” on page
52 gives more details.

■ The infinity symbol ∞, which you insert by clicking  on the Calculus toolba
or by typing [Ctrl ][Shift ]Z.

The following are examples of valid names:

alpha b

xyz700 A1_B2_C3_D4%%%

F1' a%%

The following restrictions apply to variable names:

■ A name cannot start with one of the digits 0 through 9. Mathcad interprets anyt
beginning with a digit as either an imaginary number (  or ), a binary, octal
hexadecimal number (e.g., 5o, 7h), or as a number times a variable ( ).

■ The infinity symbol, ∞, can only appear as the first character in a name.

■ Any characters you type after a period (.) appear as a subscript. This is discusse
in “Literal subscripts” on page 52.

■ All characters in a name must be in the same font, have the same point size, a
in the same style (italic, bold, etc.). Greek letters can, however, appear in any
variable name. See “Math styles” on page 67.

■ Mathcad does not distinguish between variable names and function names. T
if you define f(x), and later on you define the variable f, you will find that you cannot 
use f(x) anywhere below the definition for f.

2i 3j
3 x⋅
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■ Although you can redefine Mathcad’s names for built-in functions, constants, 
units, keep in mind that their built-in meanings will no longer exist after the 
definition. For example, if you define a variable mean, Mathcad’s built-in function 
mean(v) can no longer be used.

Tip Mathcad distinguishes between uppercase and lowercase letters. For example, diam is a different 
variable from DIAM. Mathcad also distinguishes between names in different fonts, as discu
in “Math styles” on page 67. Thus, Diam is also a different variable from Diam. 

Greek letters

There are two ways to enter a Greek variable name in Mathcad:

■ Click on the appropriate letter on the Greek toolbar. To see this toolbar, click 
on the Math toolbar, or choose Toolbars⇒Greek from the View menu.

■ Type the Roman equivalent of the Greek symbol and then press [Ctrl ]G. For 
example, to enter φ, press f[Ctrl]G . See “Greek letters” on page 349 in the 
Appendices for a table of Greek letters and their Roman equivalents.

Note Although many of the uppercase Greek letters look like ordinary capital letters, they are not the 
same. Mathcad distinguishes between Greek and Roman letters, even if they appear 
typographically equivalent.

Tip Because it is used so frequently, the Greek letter π can also be typed by pressing 
[Ctrl ][Shift ]P.

Literal subscripts 

If you include a period in a variable name, Mathcad displays whatever follows th
period as a subscript. You can use these literal subscripts to create variables with names
like  and .

To create a literal subscript, follow these steps:

■ Type the portion of the name that appears 
before the subscript.

■ Type a period (. ), followed by the portion 
of the name that is to become the subscript.

velinit uair
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Note Do not confuse literal subscripts with array subscripts, which are generated with the left brack

key ([ ) or by clicking  on the Arithmetic toolbar. Although they appear similar—a liter
subscript appears below the line, like an array subscript, but with a slight space before th
subscript—they behave quite differently in computations. A literal subscript is simply a 
cosmetic part of a variable name. An array subscript represents a reference to an array el
See Chapter 11, “Vectors, Matrices, and Data Arrays,” for a description of how to use subs
with arrays.

Operators

As described in the previous section, certain characters, like letters and digits, ma
parts of names and numbers. Other characters, like *  and +, represent “operators.” 

Operators are symbols like “+” and “−” that link variables and numbers together to 
form expressions. The variables and numbers linked together by operators are ca
operands. For example, in an expression like:

the operands for the “+” are x and y. The operands for the exponent operator are a and 

the expression . 

You type the common arithmetic operators using the standard keystrokes, like *  and 
+, you use in your spreadsheet and other applications. But all of Mathcad’s oper
can be entered with keystrokes or by clicking buttons in the Math toolbars. For exam

you insert Mathcad’s derivative operator by typing ? or by clicking  on the Calculus 
toolbar. See “Operators” on page 334 in the Appendices for a complete list of opera
Mathcad’s operators are also discussed in detail in Chapter 9, “Operators.” 

Building expressions 

You can create many mathematical expressions by simply typing in a stream of 
characters, or by inserting appropriate operators from the Math toolbars. For exa
if you type the characters

3/4+5^2=

you get the result shown at right.

On the surface, Mathcad’s equation editor seems very 
much like a simple text editor, but there’s more to it than 
this. Mathematical expressions have a well-defined struc-

ax y+

x y+
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ture and Mathcad’s equation editor is designed specifically to work within that str
ture. In Mathcad, mathematical expressions are not so much typed-in as they are

Mathcad automatically assembles the various parts that make up an expression
the rules of precedence and some additional rules that simplify entering denomin

exponents, and expressions in radicals. For example, when you type /  or click  on 
the Arithmetic toolbar to create a fraction, Mathcad stays in the denominator until 
press [Space ] to select the entire expression. 

Typing in names and numbers

When you type in names or numbers, Mathcad behaves very much like a standard
processor. As you type, you see the characters you type appear behind a vertical editing 
line. The left and right arrow keys move this vertical editing line to the left or to th
right a character at a time, just as they would in a word processor. There are, how
two important differences:

■ As it moves to the right, the vertical 
editing line leaves behind a trail. This 
trail is a “horizontal editing line.” Its 
importance becomes apparent when you 
begin working with operators.

■ Unless the equation you’ve clicked in already has an operator in it, pressing 
[Space ] turns the math region into a text region. It is not possible to turn a te
region back into a math region.

Typing in operators

The key to working with operators is learning to specify what variable or expressio
to become an operand. There are two ways to do this: 

■ You can type the operator first and fill in the placeholders with operands, or 

■ You can use the editing lines to specify what variable or expression you wan
turn into an operand.

The first method feels more like you’re building a skeleton and filling in the detai
later. This method may be easier to use when you’re building very complicated 
expressions, or when you’re working with operators like summation that require m
operands but don’t have a natural typing order.

The second method feels more like straight typing and can be much faster when
expressions are simple. In practice, you may find yourself switching back and for
the need arises.

Here’s how to create the expression  using the first method:ax y+
54  Chapter 4  Working with Math
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■ Press ̂  to create the exponent operator, 

or click  on the Arithmetic toolbar. 
You see two placeholders.

■ Click in the lower placeholder and type 
a.

■ Click in the upper placeholder.

■ Type +.

■ Click in the remaining placeholders and 
type x  and y .

To use the editing lines to create the expression , proceed as follows:

■ Type a. The line beneath the a indicates 
that a becomes the first operand of what-
ever operator you type next.

■ Press ̂  to create the exponent operator. 
As promised, a becomes the first oper-
and of the exponent. The editing lines 
now surround another placeholder. 

■ Type x+y  in this placeholder to com-
plete the expression.

Note that in this example, you could type the expression the same way you’d say 
loud. However, even this simple example already contains an ambiguity. When y
say “a to the x plus y” there’s no way to tell if you mean  or . For more 
complicated expressions, the number of ambiguities increases dramatically. 

Although you can always resolve ambiguities by using parentheses, doing so ca
quickly become cumbersome. A better way is to use the editing lines to specify t
operands of whatever operator you type. The following example illustrates this b
describing how to create the expression  instead of .

ax y+

ax y+ ax y+

ax y+ ax y+
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■ Enter a^x  as you did in the previous 
example. Note how the editing lines hold 
the x between them. If you were to type 
+ at this point, the x would become the 
first operand of the plus.

■ Press [Space ]. The editing lines now 

hold the entire expression . 

■ Now type +. Whatever was held between 
the editing lines now becomes the first 
operand of the plus.

■ In the remaining placeholder, type y .

Multiplication

A common way to show multiplication between two variables on a piece of paper 
place them next to each other. For example, expressions like ax or  are easily 
understood to mean “a times x” and “a times the quantity x plus y,” respectively. 

This cannot be done with Mathcad variables for the simple reason that when you
ax , Mathcad has no way of knowing whether you mean “a times x” or “the variable 
named ax.” Similarly, when you type a(x+y) , Mathcad cannot tell if you mean “a 
times the quantity x plus y” or whether you mean “the function a applied to the argument 

.” 

Note In the special case when you type a numerical constant followed immediately by a variab
name, such as 4x , Mathcad interprets the expression to mean the constant multiplied by th
variable: . Mathcad displays a space between the constant and the variable to indica
the multiplication is implied. You can produce math notation in this way that closely 
approximates the notation you see in textbooks and reference books. However, Mathcad
reserves certain letters, such as “i” for the imaginary unit and “o” for octal, as suffixes for 
numbers, and in these cases does not attempt to multiply the number by a variable name
rather treats the expression as a single number with a suffix.

To avoid ambiguity in your everyday work, we recommend that you always pres*  
explicitly to indicate multiplication, as shown in the following example:

■ Type a followed by * . Mathcad inserts 
a small dot after the “a” to indicate mul-
tiplication.

ax

a x y+( )

x y+

4 x⋅
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■ In the placeholder, type the second fac-
tor, x .

An annotated example 

When it comes to editing equations, knowing how to use the editing lines assum
importance similar to knowing where to put the flashing vertical bar (insertion po
you see in most word processors. A word processor can use a simple vertical bar b
text is inherently one-dimensional, like a line. New letters go either to the left or to
right of old ones. An equation, on the other hand, is really two-dimensional, with a 
structure more like a trees with branches than like a line of text. As a result, Math
has to use a two-dimensional version of that same vertical bar. That’s why there are
two editing lines: a vertical line and a horizontal line.

Suppose, for example, that you want to type the slightly more complicated expre

Watch what happens to the editing lines in the following steps:

■ Type x-3*a^2 . Since the editing lines 
contain just the “2,” only the “2” be-
comes the numerator when you press the 
/ . Since we want the whole expression, 

, to be the numerator, we must make the editing lines hold that entir
expression.

■ To do so, press [Space ]. Each time you 
press [Space ], the editing lines hold 
more of the expression. You need to 
press [Space ] three times to enclose the 
entire expression.

■ Now press /  to create a division bar, or 

click  on the Arithmetic toolbar. 
Note that the numerator is whatever was 
enclosed between the editing lines when 
you pressed / .

■ Now type -4+  and click  on the 
Arithmetic toolbar. Then type y+1  un-
der the radical to complete the denomi-
nator. 

x 3 a2⋅–

4– y 1++
------------------------------

x 3 a2⋅–
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■ To add something outside the radical 
sign, press [Space ] twice make the ed-
iting lines hold the radical. For example, 
to add the number π to the denominator, 
press [Space ] twice.

■ Press +. Since the editing lines were 
holding the entire radical, it is the entire 
radical that becomes the first operand 
when you press +.

■ Click  on the Arithmetic toolbar. 
This is one of Mathcad’s built-in vari-
ables.

Editing expressions

This section describes how to make changes to an existing expression.

The simplest changes you can make are discussed in “Changing a name or numb
page 59. Here, the underlying tree structure of a math expression doesn’t matter
result, the equation editor behaves very much like a text editor.

Complexities in editing equations arise from working with operators. That’s beca
it’s only when you start working with operators that the underlying structure of a m
expression shows up. We describe how to insert an operator, apply an operator
existing expression, and delete an operator.

The equation editor normally works from left to right. If you want to insert an opera
before an existing expression, or if you want to apply a function to an existing 
expression, see “Inserting an operator” on page 59 and “Applying a function to a
expression” on page 65.

Although Mathcad inserts parentheses wherever required to prevent ambiguity, 
may want to add parentheses to clarify an expression or delete extraneous paren
To do so, use the techniques described in “Inserting parentheses” on page 64 a
“Deleting parentheses” on page 65.

When working with a complicated expression, it is often easier to work with more
manageable subexpressions within it. The sections “Moving parts of an expressio
page 66 and “Deleting parts of an expression” on page 67 describe how to use Cut, 
Copy, and Paste and the equation drag and drop feature to do so.
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Changing a name or number      

To edit a name or number:

■ Click on it with the mouse. This places the vertical editing line wherever you clic
the mouse. 

■ Move the vertical editing line if necessary by pressing the [→] and [←] keys.

■ If you type a character, it appears just to the left of the vertical editing line. Pres
[Bksp ] removes the character to the left of the vertical editing line. Pressing 
[Delete ] removes the character to the right of the vertical editing line.

If you need to change several occurrences of the same name or number, you ma
it useful to choose Replace from the Edit  menu. To search for a sequence of characte
choose Find from the Edit  menu. These commands are discussed further in “Text too
on page 82.

Inserting an operator

The easiest place to insert an operator is between two characters in a name or t
numbers in a constant. For example, here’s how to insert a plus sign between tw
characters:

■ Place the editing lines where you want 
the plus sign to be.

■ Press the + key, or click  on the 
Arithmetic toolbar.

Note You never need to insert a space when typing an equation. Mathcad inserts spaces autom
around operators wherever doing so is appropriate. If you do try to insert a space, Mathca
assumes you meant to type text rather than math and converts your math region into a text
accordingly.
 

Operators such as division and exponentiation result in more dramatic formatting
changes. For example, when you insert a divide sign, Mathcad moves everything
comes after the divide sign into the denominator. Here’s how you insert a divide 

■ Place the editing lines where you want 
the divide sign to be. 

■ Press the /  key or click  on the 
Arithmetic toolbar. Mathcad reformats 
the expression to accommodate the divi-
sion.
Editing expressions 59
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Some operators require only one operand. Examples are the square root, absolute
and complex conjugate operators. To insert one of these, place the editing lines on
side of the operand and press the appropriate keystroke. Many of these operato
available on the Arithmetic toolbar as well. For example, to turn x into  do the 
following:

■ Place the editing lines around the “x,” 
either preceding or following the charac-
ter.

■ Press \  to insert the square root operator, 

or click  on the Arithmetic toolbar.

Applying an operator to an expression

The methods described in the previous section work most predictably when you 
to apply an operator to a variable or a number. If, however, you want to apply an ope
to an entire expression, there are two ways to proceed:

■ Surround that expression in parentheses and proceed as described in the pre
section, or

■ Use the editing lines to specify the expression to which you want to apply the
operator.

Although the first method may be more intuitive, it is slower since you need to ty
pairs of parentheses. The more efficient, second method is the subject of this se
The sections “Inserting parentheses” on page 64 and “Deleting parentheses” on 
65 describe ways to work with parentheses more efficiently. 

The editing lines consist of a horizontal line and a vertical line that moves left to r
along the horizontal line. To make an operator apply to an expression, select the
expression by placing it between the two editing lines. The following examples s
how typing *c  results in completely different expressions depending on what was
selected.

■ Here, the two editing lines hold only the 
numerator. This means any operator you 
type will apply only to the numerator.

■ Typing *c  results in this expression. 
Note how the expression held between 
the editing lines became the first operand 
of the multiplication.

■ Here, the editing lines hold the entire 
fraction. This means any operator you 
type will apply to the entire fraction.

x
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■ Typing *c  results in this expression. 
Note how everything between the editing 
lines became the first operand of the 
multiplication. 

■ Here, the editing lines hold the entire 
fraction as they did in the previous exam-
ple. However, this time the vertical edit-
ing line is on the left side instead of on 
the right side. 

■ Typing *c  results in this expression. 
Note how the expression enclosed by the 
editing lines became the second rather 
than the first operand of the multiplica-
tion. This happened because the vertical 
editing line was on the left side rather than the right side. 

Controlling the editing lines

You use the following techniques to control what’s between the editing lines:

■ Click on an operator. Depending on where on the operator you click, you’ll find
vertical editing line either on the left or on the right of the operator, with the 
horizontal line selecting an operand of the operator. If you want to move the ver
editing line from one side to the other of the currently selected expression, pr
[Insert ].

■ Use the left and right arrow keys to move the vertical editing line one characte
a time. The horizontal editing line selects an operand of the nearest operator. If
expression contains built-up fractions, you can also use the up and down arrow
to move the editing lines.

■ Press [Space ] to select progressively larger parts of the expression with the edi
lines. Each time you press [Space ], the editing lines enclose more and more of th
expression, until eventually they enclose the entire expression. Pressing [Space ] 
one more time brings the editing lines back to where they were when you sta

Tip You can also drag-select a parts of an expression to hold it between the editing lines. When 
do this, the selected expression is highlighted in reverse video. Note that whatever you typ
overwrites the highlighted expression.

The following example walks you through a short cycle of using [Space ]:

■ This is the starting position. The two 
editing lines hold just the single variable 
“d.”
Editing expressions 61
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■ Pressing [Space ] makes the editing 
lines grow so that they now hold the 
entire denominator.

■ Pressing [Space ] once makes the edit-
ing lines grow again so that they now 
hold the entire expression. 

■ At this point, the editing lines can’t be-
come any longer. Pressing [Space ] 
brings the editing lines back to the start-
ing point of the cycle.

You’ll notice that in stepping through the previous cycle there was never an inter
diate step in which the editing lines held just the numerator. Nor was there ever a
in which the editing lines held just the a or just the b in the numerator. That’s because
the sequence of steps the editing lines go through as you press [Space ] depends on 
the starting point of the cycle.

To set the starting point of the cycle, either click on the appropriate part of the expre
as described earlier, or use the arrow keys to move around the expression. The 
keys walk the editing lines through the expression in the indicated direction. Kee
mind, however, that the idea of “up” and “down” or “left” and “right” may not alway
be obvious, particularly when the expression becomes very complicated or if it invo
summations, integrals, and other advanced operators.

Note Editing of strings differs from editing of other math expressions because you must use the 
keys or click outside the string to move out of a string. Pressing [Space ], which can be used 
in other expressions to change the position of the editing lines, is interpreted as just anoth
character in a string.

Deleting an operator

To delete an operator connecting two variable names or constants:

■ Place the vertical editing line after the 
operator.

■ Press [BkSp].

Now you can easily insert a new operator to replace the one you deleted just by t
it in.
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Tip You can also delete an operator by placing the editing lines before it and pressing [Delete ]. 

In the above examples, it is easy to see what “before” and “after” mean because
expressions involved naturally flow from left to right, the same way we read. Fract
behave the same way. Since we naturally say “a over b,” putting the editing lines “after” 
the division bar means putting them just before the b. Similarly, putting the editing lines 
“before” the division bar means putting them immediately after the a. The following 
example illustrates this:

■ Place the vertical editing lines after the 
division bar. 

■ Press [BkSp].

To delete an operator having only one operand (for example, ,  or ):

■ Position the editing lines just after the 
operator. 

■ Press [BkSp].

For certain operators, it may not be clear where to put the editing lines. For exam
it is not clear when looking at  or  what “before” and “after” mean. When this
happens, Mathcad resolves the ambiguity by referring to the spoken form of the 
expression. For example, since you read  as “x conjugate,” the bar is treated as bein
after the x.

Inserting a minus sign 

The minus sign that means “negation” uses the same keystroke as the one that 
“subtract.” To determine which one to insert, Mathcad looks at where the vertica
editing line is. If it’s on the left, Mathcad inserts the “negation” minus sign. If it’s o
the right, Mathcad inserts the “subtract” minus sign. To move the vertical editing 
from one side to the other, use [Insert ].

The following example shows how to insert a minus sign in front of “sin(a).”

■ Click on the sin(a). If necessary, press 
[Space ] to select the entire expression.

x x x!

x x

x
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■ If necessary, press [Insert ] to move the 
vertical editing line all the way to the left.

■ Type - , or click  on the Arithmetic 
toolbar, to insert a minus sign.

If what you really want to do is turn  into , insert another operato
(say, “+”) as described in the section “Inserting an operator” on page 59. Then rep
the operator with a minus sign as described in the section “Deleting an operator
page 62. Notice that in Mathcad the unary negation symbol in the expression 
appears smaller than the minus sign in expressions such as .

Inserting parentheses    

Mathcad places parentheses automatically as needed to maintain the precedenc
operations. There may be instances, however, when you want to place parenthe
clarify an expression or to change the overall structure of the expression. You can 
insert a matched pair of parentheses all at once or insert the parentheses one at
We recommend you insert a matched pair since this avoids the possibility of unma
parentheses.

To enclose an expression with a matched pair of parentheses:

■ Select the expression by placing it be-
tween the editing lines. Do this by click-
ing on the expression and pressing 
[Space ] one or more times.

■ Type the single-quote key (‘ ), or click 

 on the Arithmetic toolbar. The se-
lected expression is now enclosed by pa-
rentheses. 

It is sometimes necessary to insert parentheses one at a time using the (  and )  keys. 
For example, to change  to  do the following:

■ Move the editing lines just to the left of 
the b. Make sure the vertical editing line 
is on the left as shown. Press [Insert ] 
if necessary to move it over.

■ Type ( . Now click to the right of the c. 
Make sure the vertical editing line is to 
the right as shown. Press [Insert ] if 
necessary to move it over.

a( )sin 1 a( )sin–

a( )sin–
1 a( )sin–

a b– c+ a b c+( )–
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■ Type ) .

Deleting parentheses

You cannot delete one parenthesis at a time. Whenever you delete one parenthe
Mathcad deletes the matched parenthesis as well. This prevents you from inadver
creating an expression having unmatched parentheses.

To delete a matched pair of parentheses:

■ Move the editing lines to the right of the 
“(”.

■ Press [BkSp]. Note that you could also 
begin with the editing lines to the left of 
the “)”and press [Delete ] instead.

Applying a function to an expression 

To turn an expression into the argument of a function, follow these steps:

■ Click in the expression and press 
[Space ] until the entire expression, 

, is held between the editing 
lines. 

■ Type the single-quote key (‘ ), or click 

 on the Arithmetic toolbar. The se-
lected expression is enclosed by paren-
theses.

■ Press [Space ]. The editing lines now 
hold the parentheses as well.

■ If necessary, press the [Insert ] key. 
The vertical editing line switches to the 
left side. If the vertical editing line is 
already on the left side, skip this step.

■ Now type the name of the function. If the 
function you wish to use is a built-in 
function, you can also choose Function 

from the Insert menu or click  on the Standard toolbar and double-click th
name of the function.

��
��
��

w t⋅ k z⋅–
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Moving parts of an expression    

The menu commands Cut, Copy, and Paste from the Edit menu are useful for editing 
complicated expressions. They function as follows:

■ Cut (  on the Standard toolbar) deletes whatever is between the editing lin
and copies it to the Clipboard.

■ Copy (  on the Standard toolbar) takes whatever is between the editing lin
and copies it to the Clipboard.

■ Paste (  on the Standard toolbar) takes whatever is on the Clipboard and pl
it into your worksheet, either into a placeholder or into the blank space betwe
other regions.

The Copy and Paste commands use the Clipboard to move expressions from one p
to another. You can, however, bypass the Clipboard by using Mathcad’s equation drag 
and drop feature.

Suppose you want to build the expression

■ Drag-select the argument to the cosine 
function so that it is highlighted in reverse 
video.

■ Press and hold down [Ctrl ] and the 
mouse button. The pointer changes to in-
dicate that it carries the selected expres-
sion with it. It continues to carry the 
selected expression until you release the mouse button.

■ With the mouse button still held down, 
drag the pointer over the placeholder.

■ Release the mouse button. The pointer 
drops the expression into the placeholder. 
It then recovers its original form.

Tip You can drag and drop expressions, or even entire math regions, into placeholders in oth
expressions or into any blank space in your worksheet. Just be sure you don’t let go of the 
button before you’ve dragged the expression to wherever you want to drop it. If you’re tryin
drop the expression into a placeholder, be sure to position the pointer carefully over the 
placeholder.

wt x+( )cos wt x+( )sin+
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Deleting parts of an expression 

You can delete part of an expression by using either the [Delete ] key or the [BkSp] 
key. If you use this method, whatever you delete is not placed on the Clipboard. This 
is useful when you intend to replace whatever you delete with whatever is current
the Clipboard. 

To delete part of an expression without placing it on the Clipboard:

■ Drag-select the part of the expression (in 
this case, the numerator) so that it is 
highlighted in reverse video.

■ Press [Delete ] or [BkSp]. This re-
moves the numerator and leaves behind 
a placeholder.

Note If you select an expression with the editing lines instead of drag-selecting as shown above
must press [Bksp ] or [Delete ] twice to remove it. In this case, [Bksp ] removes the expression
to the left of the editing lines, and [Delete ] removes to the right.

Math styles   

You may already have encountered styles in your other applications to determine the
appearance of text or other elements. By making changes to text styles rather th
individual text elements in a word processing document, you can make sweeping
strikingly uniform changes in the way that documents looks. (Mathcad also supp
styles to determine the appearance of Mathcad text regions, as described in Cha
“Working with Text.”) You can get this same kind of leverage by using math styles to 
assign particular fonts, font sizes, font styles and effects, and colors to the eleme
your math expressions. 

Mathcad has predefined math styles that govern the default appearance of all the
in your worksheet, but you can define and apply additional styles to enhance the
appearance of your equations.

Mathcad’s predefined math styles are:

■ Variables, which governs the default appearance of all variables.

■ Constants, which governs the default appearance of all numbers you type in m
regions as well as all numbers that appear in results.

Whenever you type a variable name, Mathcad: 
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■ Assigns to it a math style named “Variables.”

■ Looks up the font, font size, and font style and effects associated with “Variabl

■ Displays the variable name using the characteristics associated with the style n
“Variables.”

Similarly, when you type a number or when a result is calculated, Mathcad:

■ Assigns to it a math style named “Constants.”

■ Looks up the font, font size, and font style and effects associated with “Consta

■ Displays the number using the characteristics associated with the style name
“Constants.”

Editing math styles

To change Mathcad’s default style for all variables and plots:

■ Click on a variable name in your worksheet.

■ Choose Equation from the Format menu. The 
style name “Variables” is selected.

■ Click “Modify” to change the font associated 
with the “Variables” style. You’ll see a dialog 
box for changing fonts.

■ Click “OK.” Mathcad changes the font of all 
variables in the worksheet.

If you change the Variables style, you may also want to change the style used fo
numbers so that the two look good together. To do so:

■ Click on a number. 

■ Choose Equation from the Format menu to see the Equation Format dialog bo
The style name “Constants” is now selected.

■ Follow the procedure given above for modifying the Variables style. 

You can also use the Formatting toolbar to change the font, font size, or font sty
associated with a math style. For example, to use the Formatting toolbar to modify 
of the settings for the Variables math style, click on a variable, then click on the 
appropriate Formatting toolbar button to make variables bold, italic, or underline
to specify the font or point size in the drop-down lists.
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Note Mathcad’s line-and-character grid does not respond automatically to changes in the font s
used in text and math. Changing font characteristics, particularly font sizes, may cause re
to overlap. You can separate these regions by choosing Separate Regions from the Format 
menu.

You may wish to have your equations display in a different color than your default
regions to avoid confusing the two. To change the default color of all equations in 
worksheet,

■ Choose Equation from the Format menu. 

■ Select a color in the “Default Equation Color” drop-down list.

■ Click “OK.”

Applying math styles

The “Variables” and “Constants” styles govern the default appearance of all mat
your worksheet. These two style names cannot be changed. You may, however, 
and apply additional math styles, named as you choose, in your worksheets and
templates.

To see what math style is currently assigned to a name or number, simply click i
name or number, and look at the style window on the Formatting toolbar.

Alternatively, click the name or number and 
choose Equation from the Format menu. The 
math style associated with whatever you clicked 
on appears in the drop-down list in the Equation 
Format dialog box. 

If you click on the button to the right of “Vari-
ables” in either the Formatting toolbar or the 
Equation Format dialog box, you’ll see a drop-
down list of available math styles. If you now 
choose “User 1” and click “OK,” a new math style is applied to the selected elem
and its appearance changes accordingly. 

In this way you can apply any of a variety of math styles to:

■ individual variable names in an expression, or

■ individual numbers in a math expression (but not in computed results, which alw
display in the “Constants” style).

For example, many math books show vectors in a bold, underlined font. If you wa
use this convention, do the following:

■ Choose Equation from the Format menu.
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■ Click the down arrow beside the name of the current math styles to see a drop-
list of available math styles.

■ Click on an unused math style name like “User 1” to select it. The name “Use
should now appear in the “New Style Name” text box. Click in this text box an
change the name to something like “Vectors.”

■ Click “Modify” to change this style to a bold, underlined font.

This creates a math style called “Vectors” with the desired appearance. When yo
done defining the style, click “OK.”

Now rather than individually changing the font, font size, and font style for name
vectors, you can simply change their math styles. 

Note All names, whether function names or variable names, are font sensitive. This means thatx and 
x refer to different variables, and f(x) and f(x) refer to different functions. In deciding whether 
two variable names are the same, Mathcad actually checks math styles rather than fonts. To 
avoid having distinct variables that look identical, don’t create a math style with exactly th
same font, size, and other characteristics as another math style.

Saving math styles

Once you’ve completed a set of math styles that you like, you need not repeat the pr
for other worksheets. You can save math style information by saving a workshee
template.

To apply math style information to another worksheet, open your template from 
File menu and copy the contents of the worksheet to the template. For more inform
about worksheet templates, see Chapter 7, “Worksheet Management.”
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